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Introducing the Veritas
agent for Sybase
This chapter contains the following topics:
■

About the Veritas agent for Sybase

■

Supported software

■

Agent functions

■

Monitoring options for the Sybase agent

■

Typical Sybase configuration in a VCS cluster

About the Veritas agent for Sybase
The Veritas High Availability Agent for Sybase brings the configured Sybase
servers online, monitors them, and takes them offline.
The package contains two agents:
■

Agent for SQL Server: Sybase

■

Agent for Backup Server: SybaseBk

The agents include type declarations and agent executables, and are represented
with Sybase and SybaseBk resource types, respectively. Both agents work
together to make Sybase highly available in a VCS cluster.
Note: Veritas agent for Sybase provides “active/passive” support for Sybase. For
“active/active” support, contact Sybase for their agent.
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Supported software
The Veritas agent for Sybase supports the following software versions:

Sybase

Sybase Adaptive Server Enterprise (ASE) 12.5.x and 15.0

Veritas Cluster Server

VCS 5.0 on HP-UX

HP-UX

HP-UX 11i version 3.0

Agent functions
The agent can perform different operations or functions on the database. These
functions are online, offline, monitor, and clean.

Agent for SQL Server: Sybase
The agent for Sybase starts a Sybase SQL Server, monitors the server processes,
and shuts down the server.
Table 1-1 lists the Sybase agent for SQL Server operations.
Table 1-1

Sybase agent for SQL Server operations

Agent operation Description
Online

Starts the Sybase SQL Server by using the following command.
startserver -f $SYBASE/$SYBASE_ASE/install/
RUN_$Server

Monitor

In the basic monitoring mode, the agent scans process table for the
dataserver process. In detail monitoring mode, the agent runs the
script that is specified in Monscript as an option.
See “Monitoring options for the Sybase agent” on page 10.

Offline

Stops the Sybase SQL Server by using the isql command in the
following manner:
The agent first executes the command shutdown with wait. If
this command fails, the offline script executes shutdown with
nowait.
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Table 1-1

Sybase agent for SQL Server operations

Agent operation Description
Clean

Forcefully stops the Sybase SQL Server by using the isql command
in the following manner:
The agent first executes the command shutdown with wait. If
this command fails, the clean script executes shutdown with
nowait.
If the process does not respond to the shutdown command, the
agent scans the process table for the processes that are associated
with the configured database and kills them

Agent for Backup Server: SybaseBk
The agent for SybaseBk starts a Sybase Backup Server, monitors the server
process, and shuts down the server.
Table 1-2 lists the Sybase agent for Backup Server operations.
Table 1-2

Sybase agent for Backup Server operations

Agent operation Description
Online

Starts the Sybase Backup Server by using the following command.
startserver -f $SYBASE/$SYBASE_ASE/\
install/RUN_$BackupServer

Monitor

Scans the process table for the backupserver process.

Offline

Stops the Sybase Backup Server by using the isql command in the
following manner:
The agent first executes the command shutdown SYB_BACKUP
with wait. If this command fails, the offline script executes
shutdown SYB_BACKUP with nowait.

Clean

Forcefully stops the Sybase Backup Server by using the isql
command in the following manner:
The agent first executes the command shutdown SYB_BACKUP
with wait. If this command fails, the clean script executes
shutdown SYB_BACKUP with nowait.
If the process does not respond to the shutdown command, the
agent scans the process table for the processes that are associated
with the configured Sybase Backup Server and kills them.
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Monitoring options for the Sybase agent
The Veritas agent for Sybase provides two levels of application monitoring:
basic and detail.
In the basic monitoring mode, the agent for Sybase monitors the Sybase daemon
processes to verify whether they are running.
In the detail monitoring mode, the agent performs a transaction on a test table
in the database to ensure that Sybase functions properly.
See “Setting up detail monitoring for the agent” on page 29.
When the agent detects that the configured Sybase server is not running on a
system, the Sybase service group is failed over to the next available system in
the service group’s SystemList. The configured Sybase servers are started on the
new system, thus ensuring high availability for the Sybase server and data.

Typical Sybase configuration in a VCS cluster
In a typical configuration, VCS is configured in a two node cluster. The Sybase
data is installed on shared disks. The Sybase server binaries can be installed
locally on both nodes or on shared disks. The agent for Sybase is installed on
both nodes. The shared disks can be managed using Symantec Volume Manager
(VxVM).
Figure 1-1 illustrates a sample configuration in which the Sybase servers,
including binaries and data are installed completely on shared disks or shared
cluster disk groups managed using VxVM.
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Figure 1-1

Sybase binaries and data on shared disks

VCS private network

Node 1

Node 2

Shared disks / Cluster disk groups
Sybase
binaries &
data

Public network

Figure 1-2 illustrates a sample configuration in which Sybase binaries are
installed locally on each node in the cluster and the Sybase data is on shared
disks or shared cluster disk groups managed using VxVM.
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Figure 1-2
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Installing and configuring
Sybase
This chapter contains the following topics:
■

VCS requirements for installing Sybase

■

Installing Sybase in a VCS environment

VCS requirements for installing Sybase
Review the following prerequisites and requirements before you install Sybase
in a VCS cluster. Before installing Sybase, make sure the systems in the cluster
have adequate resources to run Sybase and VCS.

Sybase installation directory
The Sybase installation directory can be located on a local disk or a shared
storage.
■

If the Sybase binaries are installed on a local disk, verify that the
installation path is same on all the nodes in the cluster. Make sure the
Sybase configuration files are identical on all the nodes in the cluster.

■

If the Sybase binaries are installed on shared disks, make sure the mount
points for the shared disks are same on all the nodes. The Sybase
installation directory is specified by the environment variable $SYBASE.
Create the same $SYBASE mount points on each system.

$SYBASE directory on shared disks
All database devices, including master devices, sybsystemprocs, and
information about Sybase user must be located on shared disks. If the database
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devices are created on file systems, the file systems must also be located on
shared disks. Create the same file system mount points on each system to access
the shared disks.

Database dbspaces
If you use shared disks for dbspaces, change the permissions, or access mode on
the disk groups that store the Sybase data. Change the permissions for sybase to
660.
For example, if you use Symantec Volume Manager, type:
vxedit -g diskgroup_name set group= dba
user=sybase mode=660 volume_name

Transparent TCP/IP failover
For Sybase server failover to be transparent to Sybase clients, create an IP
address as part of the Sybase service group. This IP address must match the
dataserver and backup server entries in the $SYBASE/interfaces file. For
information on the format for adding entries to the $SYBASE/interfaces file,
refer to the Sybase documentation.

System user for Sybase home directory
Make sure you have a system user, with the same username and ID, on all cluster
nodes. Also, the system user should have the ownership of the Sybase home
directory on the shared disk. Type the following commands:
useradd -u user_id user_name
chown -R user_name $SYBASE

Language settings
For the Veritas agent for Sybase to function with the desired locale, make sure
that the Sybase installation has the correct localization files. For example, if the
Sybase server requires ‘LANG=en_US.UTF-8’ environment variable, verify that
the localization files corresponding to language ‘en_US.UTF-8’ are installed
with Sybase Also, edit the file $VCS_HOME/bin/vcsenv to contain the following:
LANG=en_US.UTF-8;export LANG

Note that this change would affect all agents that are configured on the nodes.

Configuring Sybase for detail monitoring
This section describes the tasks to be performed for configuring a Sybase server
to be monitored in detail.
See “Setting up detail monitoring for the agent” on page 29.
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Note: The steps that are described here are specific to the sample script,
SqlTest.pl, provided with the agent. If you use a custom script for detail
monitoring, you must configure the Sybase database accordingly.
Perform these steps only once in a Sybase cluster.
To set up Sybase for detail monitoring
1

Source the SYBASE.sh file or SYBASE.csh file (depending on the user shell)
to set the $SYBASE and $SYBASE_ASE environment variables.

2

Start the Sybase server.
$SYBASE/$SYBASE_ASE/install/RUN_server_name

3

Start the Sybase client on any cluster node.
isql -Usa

Enter the administrator password when prompted to do so.
4

Connect to the master database.
use master
go

5

Create a Sybase user account.
sp_addlogin user_name, password
go

The detail monitor script should use this account to make transactions on
the database.
6

Create a database.
create database database_name
go

The detail monitor script should make transactions on this database.
7

If required, restrict the size of the log file for the database.
sp_dboption database_name, " log on chkpt", true
go

8

Connect to the database that is created in step 6.
use database_name
go

9

Associate the user created in step 5 with the database created in step 6.
sp_adduser user_name
go

10 Change the user to the one created in step 5.
setuser user_name
go

11 Create a table in the database.
create table table_name (lastupd datetime)

15
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go

The detail monitor script should make transactions on this table.
Note: If you use the SqlTest.pl for detail monitoring, make sure you create a
table with a lastupd field of type datetime.
12 Verify the configuration by adding an initial value to the table.
insert into table_name (lastupd) values (getdate())
go

13 Exit the database.
exit

Installing Sybase in a VCS environment
For information on how to install Sybase, refer to Sybase documentation.
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Installing, upgrading, and
removing the agent for
Sybase
This chapter contains the following topics:
■

Before you install or upgrade the agent for Sybase

■

Installing the agent for Sybase

■

Upgrading the agent for Sybase

■

Disabling the agent for Sybase

■

Removing the agent for Sybase

Before you install or upgrade the agent for Sybase
Meet the prerequisites to install the Veritas agent for Sybase.
■

Verify VCS is installed and configured. Symantec recommends installing the
VCS graphical user interface. If required, review the Veritas Cluster Server
Installation Guide.

■

Verify that Sybase is installed and configured on all cluster nodes where you
will install the agent. Review the Sybase documentation for more
information.
See “VCS requirements for installing Sybase” on page 13.

■

Verify that the sybase account is valid and identical on all cluster systems
that will run Sybase. Verify that the sybase user account has permissions to
execute Sybase binaries.
See “System user for Sybase home directory” on page 14.
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Installing the agent for Sybase
Install the Veritas agent for Sybase on each node in the cluster.
To install the agent on HP-UX systems
1

Insert the software disc into the system's disc drive.

2

Log in as superuser.

3

Set the display permission on your workstation:
xhost +myws

4

Configure the shell environment variable DISPLAY on your workstation. For
example, if your workstation has the name “myws.” type:
For Bourne or Korn shell (sh or ksh):
DISPLAY=myws:0.0
export DISPLAY

For C shell (csh or tcsh):
setenv DISPLAY=myws:0.0

Setting the DISPLAY environment variable this way enables you to use the
SD-UX graphical interface.
5

Create a mount point directory /cdrom, if it does not exist. The directory
must have read-write permissions.

6

Determine the block device file for the disk drive. The device file should
have the form /dev/dsk/c#t#d#. Type:
ioscan -fnC disk

7

Run the following commands to start PFS (Portable File System):
nohup pfs_mountd &
nohup pfsd &

8

Mount the CD. For example, to mount the CD to the mount point /cdrom,
type:
/usr/sbin/pfs_mount -t rrip /dev/dsk/clt2d0 /cdrom

where /dev/dsk/clt2d0 is the drive’s block device file.
9

Type the following command to install the agent:
swinstall -s /cdrom/hpux/appplication/\
sybase_agent/5.0/VRTSvcssy

Repeat step 1 through step 9 on all nodes that will become part of the
Sybase service group.
10 Copy the file SybaseTypes.cf from /etc/VRTSagents/ha/conf/Sybase/
directory to/etc/VRTSvcs/conf/config directory.
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Upgrading the agent for Sybase
You can upgrade the agent for Sybase from versions 3.5 or 4.1 in a VCS cluster.
Perform the following steps on each node of the VCS cluster.
To upgrade the agent for Sybase on HP-UX systems
1

Save the VCS configuration and stop the VCS engine.
haconf -dump -makero
hastop -all -force

2

Back up the configuration file, main.cf to a location on the cluster node.

3

Perform the following steps on all systems that have the agent for Sybase
installed.
■

Remove the agent for Sybase.
swremove VRTSvcssy

■

Delete the file /etc/VRTSvcs/conf/config/SybaseTypes.cf.

■

Install the Veritas agent for Sybase.
See “Installing the agent for Sybase” on page 18.

4

Copy the file SybaseTypes.cf from the /etc/VRTSagents/ha/conf/Sybase/
directory to /etc/VRTSvcs/conf/config directory.

5

Copy the main.cf from the backed up location to /etc/VRTSvcs/conf/config
directory.

6

Edit the main.cf file located under /etc/VRTSvcs/conf/config.
Perform this step only while upgrading the Veritas agent for Sybase from
3.5 to 5.0.

7

■

If you configured detail monitoring, make sure the Monscript attribute
of the Sybase resource type is configured properly.

■

Remove the Monscript attribute for the SybaseBk resource type, if
configured.

■

Replace the password specified for the SApswd attribute (of Sybase and
SybaseBk resources) and UPword attribute (of Sybase resource) with
encrypted passwords.
See “Encrypting passwords” on page 28.

■

Save the main.cf file.

Verify the configuration.
cd /etc/VRTSvcs/conf/config
hacf -verify

8

Start VCS on the local node.

9

Start VCS on other nodes.

19
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Disabling the agent for Sybase
To disable the agent on a system, you must first take the Sybase service group
offline. You can stop the application completely, or switch the service group to
another system.
To disable the agent for Sybase
1

Determine if the service group is online by entering:
hagrp -state service_group -sys system_name

2

If the service group is online, take it offline by entering:
hagrp -offline service_group -sys system_name

or
hagrp -switch service_group -to system_name

3

Stop the agents on the system by entering:
haagent -stop Sybase -sys system_name
haagent -stop SybaseBk -sys system_name

When you get the message “Please look for messages in the log
file,” check the file /var/VRTSvcs/log/engine_A.log for a message
confirming the agent has stopped. You can also use the ps command to
verify whether the agent has stopped.
You can remove the system, service group, or resource type from the VCS
configuration after disabling the agent on all systems. See the chapter on
reconfiguring VCS from the command line in the Veritas Cluster Server
User’s Guide for more information.

Removing the agent for Sybase
This section provides steps to remove the agent from the cluster.
To remove the agent
1

Take the Sybase and SybaseBk resources offline.

2

Stop the agent for Sybase.
haagent -stop Sybase -system

Perform this step on all nodes where the agent for Sybase is running.
3

Stop the agent for SybaseBk.
haagent -stop SybaseBk -system

Perform this step on all nodes where the agent for SybaseBk is running.
4

Type the following command to remove the agent from all nodes in the
cluster.
swremove VRTSvcssy

Installing, upgrading, and removing the agent for Sybase
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Answer prompts accordingly.
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Configuring VCS service
groups for Sybase
This chapter contains the following topics:
■

About configuring service groups for Sybase

■

Before you configure the service group

■

Configuring the service groups for Sybase

■

Configuring the service group using cluster manager (Java Console)

■

Configuring the service group using the command line

■

Encrypting passwords

■

Setting up detail monitoring for the agent

About configuring service groups for Sybase
Configuring the Sybase service group involves configuring service group
resources and defining attribute values for the configured resources. You must
have administrator privileges to create and configure a service group. Before
you configure the agent, review the Sybase resource types and their attributes.

Before you configure the service group
Meet the following prerequisites to configure the Veritas agent for Sybase.
■

Verify that Sybase is installed and configured on all cluster nodes where you
configure the service group.
See “VCS requirements for installing Sybase” on page 13.

■

Verify the Veritas agent for Sybase is installed on all cluster systems.
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See “Installing the agent for Sybase” on page 18.
■

Verify the type definition for Veritas agent for Sybase is imported into the
VCS engine.
See “Importing the SybaseTypes.cf file” on page 24.

Importing the SybaseTypes.cf file
Before you configure the Sybase service group, you must import the
SybaseTypes.cf file to the VCS engine.
To import using the Cluster Manager
1

Start Cluster Manager and log on to the cluster.

2

From the File menu select Import Types.

3

In the Import Types dialog box, select the file:
/etc/VRTSagents/ha/conf/Sybase/SybaseTypes.cf

4

Click Import.

5

Save the configuration.

To import using the command line
1

Log in to a cluster system as superuser.

2

Make the cluster configuration as read-only. This action ensures that all
changes to the existing configuration have been saved and further changes
are prevented while you modify main.cf:
haconf -dump -makero

3

To ensure that VCS is not running while you edit main.cf, issue the following
command to stop the VCS engine on all systems. Leave the resources that
are available online.
hastop -all -force

4

Make a backup copy of the main.cf file.
cd /etc/VRTSvcs/conf/config
cp main.cf main.cf.orig

5

Edit the main.cf file to include the SybaseTypes.cf file.
include "SybaseTypes.cf"

The Sybase types definition is imported to the VCS engine. The agent for
Sybase can be configured without interrupting or stopping VCS.

Configuring the service groups for Sybase
You can configure the service groups for Sybase using the following methods:
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■

By using VCS Cluster Manager (Java Console) to edit a resource group
template for the agent.
See “Configuring the service group using cluster manager (Java Console)”
on page 25.

■

By using the types configuration files and directly editing the sample
main.cf file supplied with the agent. This method requires you to restart
VCS before the configuration takes effect.
See “Configuring the service group using the command line” on page 27.

Configuring the service group using cluster
manager (Java Console)
A template for the Sybase resource groups is automatically installed with the
Veritas agent for Sybase. Using the VCS Cluster Manager (Java Console), you can
view the template, which displays the Sybase service group, its resources and
their attributes. You can dynamically modify the attributes’ values as necessary
for your configuration.
To configure a service group from the Java Console
1

Make sure that the Sybase type definition file SybaseTypes.cf is imported in
your configuration.
See “Importing the SybaseTypes.cf file” on page 24.

2

Launch the Cluster Configuration wizard using any of the following ways:
■

From the Cluster Explorer menu, select Tools > Configuration Wizard.

If no service groups exist on the system, Cluster Explorer prompts you
to launch the Cluster Configuration wizard. Click Yes when prompted.
The Loading Templates Information window appears, and launches the
wizard.

■

3

Review the information in the Welcome dialog box and click Next.

4

Specify the name of the service group and the target systems on which the
service group is configured.
■

Enter the name of the service group.

■

From the Available Systems box, select the systems on which to
configure the service group.

■

Click the right arrow to move the selected systems to the Systems for
Service Group box. To remove a system from the box, select the system
and click the left arrow.
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■

Specify system priority for the service group to failover. System
priority is numbered sequentially, with the lowest assigned number
denoting the highest priority.

■

Select the Service Group Type as Failover and click Next.

5

On the Would you like to use a template to configure the service group?
dialog box, click Next to configure the service group using a template.

6

Select the SybaseGroup template to configure a Sybase service group.
If applicable, a window opens notifying that names of some resources
within the new service group are already in use. Resolve the name clashes,
if any and click Next.

7

Click Next to create the service group that is based on the selected template.
A progress indicator displays the percentage of the commands that are
executed to create the service group. The actual commands are displayed at
the top of the indicator.

8

After the service group is created, click Next to edit the attributes for the
resources.
The left pane in the dialog box lists all the resources for the Sybase service
group. Select a resource from the left pane to list the attributes on the right
pane. The attributes in bold denote mandatory attributes. You can modify
the attribute values.
See “Editing resource attributes” on page 26.

9

Click Finish to accept the default values and complete the configuration.

Editing resource attributes
Edit the resource attributes to modify the values of the resources.
To edit resource attributes
1

Select the resource from the list on the left pane. The resource attributes
appear in the right pane.

2

Select the attribute to be modified and click the edit icon in the Edit column.

3

In the Edit Attribute dialog box, enter the attribute values. To modify the
scope of the attribute, choose the Global or Local option.

4

Click OK.

5

Repeat the procedure for each resource and click Finish. Edit the attributes
for all the resources according to your configuration.

6

Follow the wizard instructions to complete the configuration. Click Finish to
quit the wizard.
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Caution: For added security, you must always provide a secure value for
passwords.
See “Encrypting passwords” on page 28.

Configuring the service group using the command
line
The Veritas agent for Sybase contains a sample configuration file that can be
used as reference to directly modify your present configuration file. This
method requires you to restart VCS before the configuration takes effect.
To configure a service group from the command line
1

Log in to a cluster system as superuser.

2

Make sure the Sybase type definition is imported into VCS engine.
See “Importing the SybaseTypes.cf file” on page 24.

3

Edit the main.cf file. Use the file /etc/VRTSagents/ha/conf/Sybase/
sample_main.cf for reference:
■

Create a Sybase service group.

■

Create the Sybase and SybaseBk resources.
See “Sybase resource type” on page 35.
See “SybaseBk resource type” on page 39.

■

Edit the default attributes to match the parameters in your
configuration.
For added security, you must always provide a secure value for
passwords.
See “Encrypting passwords” on page 28.

■

Assign dependencies to the newly created resources. Refer to the
sample file /etc/VRTSagents/ha/conf/Sybase/sample_main.cf.
See the Veritas Cluster Server User’s Guide for more information on
assigning dependencies.

4

Save and close the file.

5

Verify the syntax of the file /etc/VRTSvcs/conf/config/main.cf:
hacf -verify config

6

Start VCS on local node:
hastart

7

Start VCS on other nodes.
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8

Verify that all Sybase service group resources are brought online:
hagrp -state

9

Take the service group offline and verify that all resources are stopped:
hagrp -offline service_group -sys system_name
hagrp -state

10 Bring the service group online again and verify that all resources are
available:
hagrp -online service_group -sys system_name
hagrp -state

11 Start the VCS engine on the other node:
hastart

12 Switch the Sybase service group to the other node:
hagrp -switch service_group -to system_name

13 Verify that all Sybase service group resources are brought online on the
other node:
hagrp -state

14 On all systems, look at the following log files for any errors or status:
/var/VRTSvcs/log/engine_A.log
/var/VRTSvcs/log/Sybase_A.log
/var/VRTSvcs/log/SybaseBk_A.log

Encrypting passwords
VCS provides a vcsencrypt utility to encrypt user passwords. Encrypt passwords
before specifying them for Sybase and SybaseBk resource type definition.
Note: You need not encrypt passwords when using the VCS Cluster Manager
(Java Console) to configure attributes.
To encrypt passwords
1

From the path $VCS_HOME/bin/, run the vcsencrypt utility.
■

Type the following command:
vcsencrypt -agent

■

The utility prompts you to enter the password twice. Enter the
password and press Return.
Enter New Password:
Enter Again:

2

The utility encrypts the password and displays the encrypted password.

3

Enter this encrypted password as the value for the attribute.
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Copy the encrypted password for future reference.

Setting up detail monitoring for the agent
The Veritas agent for Sybase provides two levels of application monitoring:
basic and detail. In basic monitoring, Sybase resource monitors the Sybase
daemon processes to verify that they are continuously active.
In detail monitoring, the Sybase resource performs transactions on a test table
in the database to ensure that the Sybase server functions properly. The agent
uses the script that is defined in the attribute Monscript of the Sybase resource.
During detail monitoring, the agent executes the specified script. If the script
successfully executes, the agent considers the database available. You can
customize the default script according to your configurations.
To activate detail monitoring, the DetailMonitor attribute must be set to a
positive integer and User, UPword, Db, and Table attributes must not be empty
(""). The attribute Monscript, which contains the path of the detail monitor
script, must also exist and must have execute permissions for the root.

Enabling detail monitoring
Perform the following steps to enable detail monitoring on a database.
To enable detail monitoring
1

Make sure Sybase server is configured for detail monitoring.
See “Configuring Sybase for detail monitoring” on page 14.

2

Make the VCS configuration writable:
haconf -makerw

3

Enable detail monitoring for Sybase:
hares -modify Sybase_resource DetailMonitor 1
hares -modify Sybase_resource User user
hares -modify Sybase_resource UPword encrypted password
hares -modify Sybase_resource Db database_name
hares -modify Sybase_resource Table table_name
hares -modify Sybase_resource Monscript
“/opt/VRTSagents/ha/bin/Sybase/SqlTest.pl”

4

Save the configuration.
haconf -dump [-makero]
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Note: If detail monitoring is configured and the database is full, the SQL
queries take considerable time to commit the results. In such a case, the
monitor routine for the agent fails and attempts to fail over the service
group. This issue is not encountered if detail monitoring is not configured.

Disabling detail monitoring
Perform the following steps to disable detail monitoring
To disable detail monitoring
1

Make the VCS configuration writable:
haconf -makerw

2

Disable detail monitoring for Sybase:
hares -modify Sybase_resource DetailMonitor 0

3

Save the configuration:
haconf -dump [-makero]
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Administering VCS service
groups for Sybase
This chapter contains the following topics:
■

Bringing the service group online

■

Taking the service group offline

■

Switching the service group

■

Viewing the agent log

■

Modifying the service group configuration

Bringing the service group online
Perform the following steps to bring a service group online.
To bring a service group online
1

In the Cluster Explorer configuration tree, select the newly created service
group.

2

Right-click the service group name, and select Enable Resources. This
enables all the resources in the group.

3

Right-click the service group name, and select the systems on which to
enable the service group (Right-click>Enable>system_name or Rightclick>Enable>All).

4

Save your configuration (File>Close Configuration).

5

Right-click the service group and select to online the service group on the
system (Right-click>Online>system_name).
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Note: In the initial few cycles of bringing a service group online, the
memory usage by the agent for Sybase increases by a noticeable value.

Taking the service group offline
Perform the following steps to take a service group offline.
To take a service group offline
1

On the Service Groups tab of the Cluster Explorer configuration tree, rightclick the service group.
or
Select the cluster in the Cluster Explorer configuration tree, select the
Service Groups tab, and right-click the service group icon in the view panel.

2

Choose Offline, and choose the appropriate system from the pop-up menu
(Right-click>Offline>system_name).
Note: In the initial few cycles of taking a service group offline, the memory
usage by the agent for Sybase increases by a noticeable value.

Switching the service group
The process of switching a service group involves taking it offline on its current
system and bringing it online on the another system.
To switch a service group
1

On the Service Groups tab of Cluster Explorer configuration tree, right-click
the service group.
or
Select the cluster in the Cluster Explorer configuration tree, select the
Service Groups tab, and right-click the service group icon in the view panel.

2

Choose Switch To, and choose the appropriate system from the pop-up
menu (Right-click>Switch To>system_name).

Viewing the agent log
The Veritas agent for Sybase logs messages to the following files:
/var/VRTSvcs/log/engine_A.log
/var/VRTSvcs/log/Sybase_A.log
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/var/VRTSvcs/log/SybaseBk_A.log

Modifying the service group configuration
You can dynamically modify the Veritas agent for Sybase using several methods,
including the Cluster Manager (Java Console), Cluster Manager (Web Console),
and the command line. See the Veritas Cluster Server User’s Guide for more
information.
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Appendix

A

Resource type definition
This appendix contains the following topics:
■

About the resource type and attribute definitions

■

Sybase resource type

■

SybaseBk resource type

About the resource type and attribute definitions
The resource type represents the VCS configuration definition of the agent and
specifies how the agent is defined in the configuration file main.cf. The attribute
definitions table explains the attributes that are associated with the agent. The
required attributes table lists the attributes that must be configured for the
agent to function properly.

Sybase resource type
The resource type definition for the agent for Sybase is as follows.
type Sybase (
static str AgentDirectory = "/opt/VRTSagents/ha/bin/Sybase"
static str ArgList[] = { Server, Owner, Home, Version, SA,
SApswd, User, UPword, Db, Table,
Monscript,DetailMonitor }
str Server
str Owner
str Home
str Version
str SA
str SApswd
int DetailMonitor = 0
str User
str UPword
str Db
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str Table
str Monscript=“/opt/VRTSagents/ha/bin/Sybase/SqlTest.pl”
)

Attribute definitions
The Sybase resource has several required and optional attributes.
Table A-1 lists the required attributes.
Table A-1

Required attributes

Required
Attributes

Definition

Server

The $DSQUERY ASE name. Only one server must be configured in
a Sybase service group.
Type and dimension: string-scalar

Owner

Sybase user as defined /etc/passwd. The Sybase executables
and database files are accessed in the context of this user.
Type and dimension: string-scalar
See “System user for Sybase home directory” on page 14.

Home

The $SYBASE path to Sybase binaries and configuration files.
Type and dimension: string-scalar

Version

Version of Sybase ASE.
Type and dimension: string-scalar

SA

Sybase database administrator. This attribute is required to
connect to the ASE for shutdown.
Type and dimension: string-scalar

SApswd

Encrypted password for Sybase database administrator. This
password is required to connect to the ASE for shutdown.
Type and dimension: string-scalar
See “Encrypting passwords” on page 28.
Note: You need not specify a value for this attribute if the SA user
does not require a password.
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Table A-2 lists the optional attributes.
Table A-2
Optional

Optional attributes
Definition

Attributes
AgentDirectory

This attribute is for internal use only.
Specifies the location of the binaries, scripts, and other files
related to the agent for Sybase. Symantec recommends not to
modify the value of this attribute.
Type and dimension: static-string

DetailMonitor

Specifies whether the Sybase server is monitored in detail. Value 1
indicates that the resource monitors the Sybase server in detail.
Value 0 denotes it does not. Default is 0.
Type and dimension: int-scalar

User

The database user, in the context of which, the transactions are
performed on the database.
Type and dimension: string-scalar
Note: You must specify a value for this attribute if DetailMonitor is
set to a non-zero value.

UPword

Encrypted password for the database user.
See “Encrypting passwords” on page 28.
Type and dimension: string-scalar
Note: You must specify a value for this attribute if DetailMonitor is
set to a non-zero value. However, you need not specify a value for
this attribute if the database user does not require a password.

Db

Name of the database used for detailed monitoring. The table used
by the detail monitor script resides in this database.
Type and dimension: string-scalar
Note: You must specify a value for this attribute if DetailMonitor is
set to a non-zero value.

Table

Name of the table on which the detail monitoring script performs
the transactions.
Type and dimension: string-scalar
Note: You must specify a value for this attribute if DetailMonitor is
set to a non-zero value.
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Table A-2
Optional

Optional attributes
Definition

Attributes
Monscript

The Path to the detail monitor script; the default value for this
attribute is the path for the script, SqlTest.pl, provided with the
agent.
Type and dimension: string-scalar
Note: You must specify a value for this attribute if DetailMonitor is
set to a non-zero value.
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SybaseBk resource type
The resource type definition for the agent for Sybase is as follows.
type SybaseBk (
static str AgentDirectory = "/opt/VRTSagents/ha/bin/
SybaseBk"
static str ArgList[] = { Backupserver, Owner, Home, Version,
Server, SA, SApswd }
str Server
str Owner
str Home
str Version
str Backupserver
str SA
str SApswd
)

Attribute definitions
The SybaseBk resource has several required attributes.
Table A-3 lists the required attributes for SybaseBk resource.
Table A-3

Required attributes

Attributes

Definition

AgentDirectory

This attribute is for internal use only.
Specifies the location of the binaries, scripts, and other files that
are related to the agent for SybaseBk. Symantec recommends not
to modify the value of this attribute.
Type and dimension: static-string

Server

The $DSQUERY Backup server name.
Type and dimension: string-scalar

Owner

Sybase user as defined /etc/passwd. The Sybase executables
and database files are accessed in the context of this user.
Type and dimension: string-scalar

Home

The $SYBASE path to Sybase binaries and configuration files.
Type and dimension: string-scalar
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Table A-3

Required attributes

Attributes

Definition

Version

Version of Sybase Backup Server.
Type and dimension: string-scalar

Backupserver

The $BACKUP SYBASE Backup Server name.
Type and dimension: string-scalar

SA

Sybase database administrator. This attribute is required to
connect to the ASE for shutdown.
Type and dimension: string-scalar

SApswd

Encrypted password of Sybase database administrator. This
password is required to connect to the ASE for shutdown.
Type and dimension: string-scalar
See “Encrypting passwords” on page 28.
Note: You need not specify a value for this attribute if the SA user
does not require a password.
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Sample configuration
This appendix contains the following topics:
■

About the sample configuration for Sybase agent

■

Resource dependency graph

■

Sample configuration for a service group using LVM

■

Sample configuration for a service group using VxVM

About the sample configuration for Sybase agent
This appendix describes a typical service group that is configured to monitor the
state of Sybase servers in a VCS cluster. The sample configuration graphically
depicts the resource types, resources, and resource dependencies within the
service group. Review these dependencies carefully before you configure the
agent. For more information about these resource types, see the Veritas Cluster
Server Bundled Agents Reference Guide.

Resource dependency graph
Figure B-1 illustrates the configuration’s dependency graph.
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Figure B-1

Dependency graph
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The dependency graph depicts a single Sybase instance configuration. The
configuration contains a disk group with a single volume. The volume is
monitored using a Volume resource and mounted using a Mount resource. The
Mount resource requires Volume resource, which in turn requires the
DiskGroup resource. The service group IP address for Sybase server is
monitored using the IP and NIC resource types. The Sybase server can be started
after each of these resources are brought online. The Backup Server is started
after the Sybase SQL Server is online.
Note: If your configuration does not use Veritas Volume Manager, use the
LVMVolumeGroup and LVMLogicalVolume resource types to configure shared
storage instead of DiskGroup and Volume resource types.

Sample configuration for a service group using LVM
The following sample shows a configuration for a service group using LVM for
HP-UX systems.
include "types.cf"
include "/etc/VRTSagents/ha/conf/Sybase/SybaseTypes.cf"
cluster vcscluster (
UserNames = { admin = IhiAhcHeiDiiGqiChf }
Administrators = { admin }
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CredRenewFrequency = 0
CounterInterval = 5
)
system system1 (
)
system system2 (
)
group Sybase_group(
SystemList = { system1 = 0, system2 = 1 }
AutoStartList = { system1,system2 }
)
IP ipres (
Device = lan0
Address = "16.9.1.9"
NetMask = "255.255.0.0"
)
Mount sybase_mount (
MountPoint = "/sybase_mnt"
BlockDevice = "/dev/vg03/sybase"
FSType = vxfs
MountOpt = rw
FsckOpt = "-n"
)
NIC nicres (
Device = lan0
NetworkHosts = { "16.9.10.1", "16.9.10.2" }
)
Sybase sybase_agent (
Server = SYBASE_SERVER
Owner = sybase
Home = "/sybase_mnt/IA"
Version = "12.5.2"
SA = sa
SApswd= ""
User = vcsuser
UPword = "jxpVmxMvrXjxKvk"
Db = vcsdb
Table = vcstable
Monscript = "/opt/VRTSagents/ha/bin/Sybase/SqlTest.pl"
DetailMonitor = 1
)
SybaseBk sybase_bk_agent (
Server = SYBASE_SERVER
Owner = sybase
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Home= "/sybase_mnt/IA"
Version= "12.5.2"
Backupserver = SYBASE_SERVER_BS
SA = sa
SApswd = ""
)
LVMLogicalVolume lvolres (
LogicalVolume = sybase
VolumeGroup = vg03
)
LVMVolumeGroup lvgres (
VolumeGroup = vg03
)
lvolres requires lvgres
sybase_mount requires lvolres
ipres requires nicres
sybase_agent requires ipres
sybase_agent requires sybase_mount
sybase_bk_agent requires sybase_agent

Sample configuration for a service group using
VxVM
The following sample shows a configuration for a service group using VxVM for
HP-UX systems.
include "types.cf"
include "/etc/VRTSagents/ha/conf/Sybase/SybaseTypes.cf"

cluster vcslcuster (
UserNames = {admin = anoGniNkoJooMwoInl,
"root@system1.veritas.com" = en,
"root@system2.veritas.com" = en }
Administrators = { admin, "root@system1.veritas.com",
"root@system2.veritas.com" }
SecureClus = 1
CredRenewFrequency = 0
CounterInterval = 5
)
system system1 (
)
system system2 (
)
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group Sybase_group(
SystemList = { system1 = 0, system2 = 1 }
AutoStartList = { system1,system2 }
)
IP ipres (
Device = lan0
Address = "16.9.1.9"
NetMask = "255.255.0.0"
)
Mount sybase_mount (
MountPoint = "/sybase_mnt"
BlockDevice = "/dev/vx/dsk/sybasedg/sybase_vol"
FSType = vxfs
MountOpt = rw
FsckOpt = "-n"
)
NIC nicres (
Device = lan0
NetworkHosts = { "16.9.10.1", "16.9.10.2" }
)
Sybase sybase_agent (
Server = SYBASE_SERVER
Owner = sybase
Home= "/sybase_mnt/IA"
Version = "12.5.2"
SA = sa
SApswd= ""
User = vcsuser
UPword = "jxpVmxMvrXjxKvk"
Db = "vcsdb"
Table ="vcstable"
Monscript = "/opt/VRTSagents/ha/bin/Sybase/SqlTest.pl"
DetailMonitor = 1
)
SybaseBk sybase_bk_agent (
Server = SYBASE_SERVER
Owner = sybase
Home = "/sybase_mnt/IA"
Version = "12.5.2"
Backupserver = SYBASE_SERVER_BS
SA = sa
SApswd = ""
)
DiskGroup dgres (
DiskGroup = sybasedg
)
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Volume volres (
Volume= sybase_vol
DiskGroup=sybasedg
)
volres requires dgres
sybase_mount requires volres
ipres requires nicres
sybase_agent requires ipres
sybase_agent requires sybase_mount
sybase_bk_agent requires sybase_agent
group VxSS (
SystemList = { system1 = 0, system2 = 1 }
Parallel = 1
OnlineRetryLimit = 3
OnlineRetryInterval = 120
)
Phantom phantom_vxss (
)
ProcessOnOnly vxatd (
IgnoreArgs = 1
PathName = "/opt/VRTSat/bin/vxatd"
)
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